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Abstract

In the master course Virtual Process Planning, the software DELMIA is used as a tool for simulation

and analysis of production planning. An element in the course is for the participants to familiarize

themselves with the software through computer labs, and obtain in-depth knowledge on the subject of

virtual process and production planning. In evaluations of the course and the material used in it, it has

been revealed that the material for DELMIA is not on a desirable level, and that the material should be

revised. The criticism highlights problems with user understandability, the layout of the material, and

the lack of connection to a relatable environment. The goal of the project is to develop shorter, more

concise and more easily followed instructions for the course with a clear connection to a real case. To

achieve these goals, the group investigates the potential for improvement further. The information needed

in this investigation is collected through a supplementary questionnaire to students who participated in

the said course, this spring (2013).

At the Department of Product and Production Development (PPU), there is a laboratory called

Production Systems Laboratory (PSL). PSL consists of a production line with three cells. One of these

cells is called Low level of automation. In this cell the transmission gear of the miniature car, the line is

made to produce is assembled. By relating the new lab material to this environment and the processes

in PSL, the group is hoping to make it easier for the participants of the course to relate to the material

in the labs.

In order to familiarize themselves with the program DELMIA, the group goes through the existing

labs. A list of the most essential elements of the lab material is made. This list is later used as a guideline

for what the new material will consist of.

A list of all the items that exist within the PSL is constructed. The group then mappes out which of

these items already are represented virtually, and which of these need to be constructed in the software

CATIA.A new version of the environment of PSL is then constructed virtually, along with the processes

and operations within the cell Low level of automation. The new lab material is created with respect

to this new setting, and the elements of the real cell. Elements that are not considered relevant by the

group are removed to simplify the virtual representation, while essential elements are reworked to fit this

new situation.

A film showing a simulation of the workflow in PSL, with focus on the cell in question is produced

in DELMIA. The purpose of the film is to make the lab asignment more interesting, and to clarify the

potential of production planning.

Through out the design process of the new lab, the group continuously tests it in order to ensure that

it is adequate and at a satisfactory level.

The result of the work the group put in to the project is a new lab series that has a distinct connection

to the physical environment of PSL, with elements that are straightforward, and motivated. This is also

reinforced by the film that the group created, that shows the process in PSL. The new lab material is

compatible with DELMIA and CATIA version 5.





Sammanfattning

I masterkursen Virtual process planning används idag programmet DELMIA som ett verktyg för

simulering och analys av produktionsplanering. Ett delmoment i kursen är att deltagarna skall genomföra

datorlaborationer för att bekanta sig med DELMIA. Idag används laborationsmaterial fr̊an Dassault

Systémes, skaparen av DELMIA. Genom dessa laborationer ska deltagarna f̊a en djupare först̊aelse för

virtuell produktionsplanering.

I utvärderingar av kursen och dess material har det framkommit att laborationerna inte är p̊a en

helt önskvärd niv̊a, och att materialet bör omarbetas. Kritiken som riktas mot att använda sig av

detta material handlar om uppgiftsförst̊aelsen, uppbyggnad av laborationsmaterialet, och avsaknad av

koppling till en relaterbar miljö. Kandidatgruppen har som m̊al att arbeta fram kortare, mer koncisa och

lättföljda instruktioner till laborationerna som även har en tydlig koppling till ett verkligt exempel. För

att n̊a dessa m̊al undersöker gruppen ytterligare var förbättringspotentialen för materialet finns, genom

en kompletterande enkät till studenter som deltagit i den nämnda kursen, 2013.

P̊a institutionen för produkt och produktionsutveckling (PPU), finns det s̊a kallade Production sys-

tems laboratory, hädanefter kallat PSL. PSL best̊ar av en produktionslina med tre celler, varav en av

dessa celler heter Low level of automation. Denna cell behandlar bland annat montering av en växell̊ada

till den miniatyr-bil som hela linan är tillverkad för att kunna producera. Genom att tydligt knyta an

till det fysiska materialet i PSL, och applicera uppgiften p̊a denna miljö, hoppas kandidatgruppen öka

relaterbarheten i laborationerna.

Gruppen g̊ar igenom de befintliga laborationerna, för att sätta sig in i programmet DELIMA. En lista

över de väsentliga momenten i laborationsmaterialet görs, för att sedan använda som mall i uppbyggnaden

av de nya laborationsuppgifterna, som kandidatgruppen ska ta fram.

Det görs en kartläggning av det material som redan finns representerat virtuellt och det som behöver

konstrueras i programmet CATIA. Miljön i PSL byggs upp tillsammans med de processer och moment

som ing̊ar i cellen Low level of automation. Laborationsmaterialet utformas sedan med avseende p̊a

denna nya miljö, samt moment i den verkliga cellen. Moment som inte anses relevanta tas bort, medan

de väsentliga momenten omarbetas för att passa p̊a den nya situationen.

För att väcka intresse hos kursdeltagarna samt förtydliga möjligheterna med virtuell produktion-

splanering producerar gruppen även en film gjord i DELMIA. Filmen visar PSL-labbets arbetsg̊ang

virtuellt programmerat, ocks̊a i detta steg ligger fokus p̊a det som händer i cellen Low level of automa-

tion.

Under tiden som laborationsuppgifterna utformas, testas de även kontinuerligt av gruppen för att

säkerställa att det uppn̊ar en önskvärd niv̊a.

Resultatet är en laborationsserie som har tydligt koppling till det fysiska PSL, där alla moment är

motiverade och processen tydlig att följa. Detta förstärks även med hjälp av filmen som visar processen

i PSL. Laborationsmaterialet är kompatibelt med DELMIA och CATIA version 5.



Ordlista

3D-modell En modell av en produkt som finns virtuellt

CAD Computer Aided Design

CAD-program Program där du modellerar produkter. Exempelvis CATIA

CAM Computer Aided Manufacturing

CATIA Avancerat CAD-program för att modulera produkter i en 3D-värld

DELMIA Program för att analysera produktionsflöden med mera

PSL Production Systems Laboratory

PPU Produkt- och produktionsutveckling

VirtualDub Ett gratisprogram för att skapa filmer av bilder.
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1 Projektets förutsättningar och bakgrund

Under 1900-talets g̊ang har den massproducerande industrin genomg̊att en rejäl omstrukturering. I början

fanns en närmast omättlig marknad och framg̊ang mättes i förm̊aga att producera s̊a stora mängder varor

p̊a s̊a kort tid som möjligt. Den fria marknaden gjorde att fler och fler företag startades vilket skapade

en ny konkurrenssituation, kunderna hade helt plötsligt flera källor att köpa samma produkt fr̊an. Detta

medförde att producerande företag var tvungna att se till marknadens önskem̊al och preferenser för att bli

framg̊angsrika och skapa en stor kundkrets. De var tvungna att locka kunderna att köpa deras produkter och

detta skedde dels genom sänkta priser. Det blev även viktigare att h̊alla en högre kvalitet än konkurrenterna.

Företagen blev även tvungna att h̊alla större variantsortiment d̊a kunderna blev allt mer kräsna och ville

specificera sina inköp mer. Viktigt för företagen var att h̊alla korta ledtider och minimera förluster. Mycket

pengar lades s̊aledes p̊a produktutveckling och nya projekt.

Här kommer produktionsplaneringen in i bilden. Kund- och kvalitetsundersökningar samt produktutveckling

och lansering av nya produkter innebär höga kostnader. Det är allts̊a önskvärt att minska dessa kostnader

s̊a mycket som möjligt. (H̊ageryd, Lennart et al., 2005) Med en väl genomförd produktionsplanering kan

företagen kontrollera att tillverkningen klarar av att framställa produkterna enligt tidigare ställda krav och

m̊al. (H̊ageryd, Lennart et al., 2002) I och med produktionsplanering kontrolleras att produkter g̊ar att

montera som det är tänkt och samtidigt ges en överblick över hur produktionsflödet bör designas p̊a bästa

sätt. Detta medför att eventuella fel eller problem i design, flöde eller produktlayout kan åtgärdas redan

innan arbetet med fysiska prototyper börjat och p̊a s̊a sätt undvika väldigt stora kostnader. (H̊ageryd,

Lennart et al., 2002) Dessa kostnader uppst̊ar främst i ett senare skede av en utvecklingsprocess d̊a fysiska

tester p̊a prototyper genomförs. Om det i början av arbetet istället genomförs utförliga simuleringar kan

ändringar göras i ett tidigt skede och det fysiska testandet kan minimeras, detta för att h̊alla kostnaderna s̊a

l̊aga som möjligt. I dagens samhälle finns teknologin att tillg̊a för att göra dessa simuleringar virtuellt och

r̊adande trenden inom produktionsindustrin är att mer tid läggs p̊a simulation istället för testande, se Figur

1.

Det är inte bara ekonomiskt vinnbart att satsa p̊a produktionplanering utan även en vinst för miljön.

Genom att minska kostnaderna brukar en direkt följd vara att material̊atg̊angen minskas. Ett välplanerat

produktionssystem är även effektivt p̊a att ta vara p̊a sin energi. Detta genom att bland annat veta exakt

hur mycket som krävs och när det behövs för att producera vissa produkter. Samtidigt kan logistiken följas

och planeras bättre genom att hela produktionen är välplanerad. Detta gör produktionsplanering till ett av

m̊anga viktiga verktyg som hjälper till att skapa en h̊allbar utveckling.

Företag använder s̊a kallade CAD-program (Computer Aided Design) för att konstruera och simulera pro-

dukter och produktionssystem. Denna metod kan appliceras p̊a olika skalor, seriestorlekar och olika typer

av industrier. CAD-programmen gör det möjligt att virtuellt skapa 3D-modeller som kan användas som

underlag för ritningar, beredning, analys och simulering. (Dassault Systémes, 2013a)

Inom virtuell produktionsplanering används CAD-program. P̊a Chalmers finns en kurs som heter Virtual

process planning där DELMIA används. Det är ett program där det är möjligt att bygga upp monteringslinor

och simulera produktionsflöden. (Dassault Systémes, 2013b) DELMIA är ett systerprogram till programmet

CATIA som används för att modellera detaljer i en 3D-värld. Detaljerna som används i DELMIA skapas i

1



CATIA. Det är dessa tv̊a CAD-program som kommer användas i projektet.

Figur 1: Övre diagrammet visar hur arbetet fördelas över tid i en verklig fabrik och det undre visar hur det

ser ut om arbetet sker virtuellt. (Klintstam, Per, 2012)

P̊a institutionen Produkt- och produktionsutveckling (PPU) p̊a Chalmers tekniska högskola finns en produk-

tionslina. Produktionslinan best̊ar av ett löpande band med manuella monteringsstationer och stationära

robotar som monterar ihop en produkt. Denna lina används i ett flertal kurser, bland annat för att simulera

produktions- och monteringsflöden. Laborationssalen där linan är uppbyggd heter Production Systems Lab-

oratory, hädanefter kallat PSL. Produktionslinan är uppdelad i tre celler: Low, Mixed och High level of

automation, fokus kommer här ligga p̊a den manuella monteringen i den första cellen. Det som monteras

där är en växell̊ada av legobitar (se bilaga E). Denna transporteras sedan in i nästa cell där den placeras i

chassit till en miniatyrbil och till sist transporteras hela chassit vidare till den sista cellen där robotarmar

monterar väggar och tak p̊a bilen.

I kursen Virtual process planning som nämndes ovan används idag en serie datorlaborationer utveck-

lade av Dassault systémes, företaget som skapat DELMIA och CATIA. I laborationsmaterialet beskrivs

flera grundläggande funktioner som sedan appliceras i ett projekt där uppgiften är att montera ihop en

gräsklipparmotor. Kandidatgruppen har av institutionen ombetts att skapa en serie nya laborationer som

skall knyta an till utrustningen i den fysiska produktionslinan i PSL. Detta för att skapa en djupare först̊aelse
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för hur användbart det är att virtuellt kunna simulera produktionslinor.

Det har förekommit kritik gentemot de gamla laborationerna s̊a kandidatgruppen fick därför ta del av

föreg̊aende års kursutvärdering av Virtual process planning, detta för att se vad som kunde förbättras och

vad som kunde tas bort helt. Resultatet blev utg̊angspunkten för gruppens arbete, kursutvärderingen finns

bifogad som bilaga C.
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2 Syfte

I masterkursen Virtual process planning används idag programmet DELMIA för att simulera och analy-

sera produktionsplanering. I kursen f̊ar deltagarna genomföra en serie datorlaborationer för att lära sig

programmet och inse värdet av virtuell produktionsplanering. I kursutvärderingen fr̊an år 2012 framg̊ar

det att kursmaterialet upplevs som otydligt och att kursdeltagarna inte har f̊att en klar bild av vad som

förväntas av dem. Det har även p̊apekats att instruktionerna i laborationsmaterialet upplevts som allt för

ledande och repetitiva. Laborationerna beskriver först ett moment steg för steg för att sedan i detalj in-

struera hur momentet kan tillämpas p̊a en produkt. Detta följs slutligen upp av ytterligare en uppgift där

samtliga steg i momentet än en g̊ang repeteras. Kandidatgruppen har som m̊al att arbeta fram korta, koncisa

och mer lättföljda instruktioner till laborationerna. För att kunna n̊a dessa m̊al m̊aste gruppen undersöka

var förbättringspotentialen för materialet finns och vad som bör bevaras. Eftersom masterkursen och dess

undervisningsmaterial är p̊a engelska kommer även det nya laborationsmaterialet vara p̊a engelska.

Som tidigare nämnts är PSL en tillg̊ang som ger en god möjlighet att skapa en djupare först̊aelse för hur man

kan använda produktioinsplanering och vikten av att arbeta med detta. De befintliga laborationsmaterialet

utnyttjar inte denna tillg̊ang. Syftet med kandidatgruppens arbete är att skapa datorlaborationer som ger

utövaren en ökad kunskap inom virtuell produktionsplanering. Laborationerna kopplas till verkligheten d̊a

de bygger p̊a CAD-filer av PSL.

För att f̊a laborationerna att knytas ihop med PSL krävs att nya CAD-modeller tas fram av arbetsstationen

och växell̊adans alla delar. Innan kandidatarbetet startades var strukturen hos de befintliga CAD-filerna

sv̊arorienterad. För att underlätta för studenterna kommer gruppen skapa en ny filstruktur för de modeller

som skall användas i det nya laborationsmaterialet.

För att visa möjligheterna och väcka intresse med virtuell produktionsplanering skall gruppen även producera

en film gjord i DELMIA. Denna kommer visa arbetsg̊angen i PSL virtuellt, med fokus p̊a det som händer

i cellen Low level of automation. Filmen skall visa montering av växell̊adan i cellen. Denna film är tänkt

att visas i anslutning till laborationerna för att studenterna skall f̊a en uppfattning av vad laborationsserien

kommer att resultera i.

För att kunna genomföra kandidatarbetet krävs att kandidatgruppen har goda kunskaper inom CATIA

och DELMIA. CATIA används i ett antal kurser p̊a Chalmers varp̊a grundkompetens inom CATIA finns i

gruppen, dock kommer djupare kunskaper krävas. DELMIA är ett för gruppen tidigare okänt program där

kandidatgruppen kommer närvara p̊a föreläsningar om programmet samt ha tillg̊ang till tidigare laborationer

för att lära sig.

Sammanfattningsvis g̊ar syftet att dela upp i tre huvudsyften:

• Undersöka var förbättringspotentialen för materialet finns och vad som bör bevaras.

• Att skapa datorlaborationer som ger utövaren en ökad kunskap inom virtuell produktionsplanering.

• Att skapa en film gjord i DELMIA som visar möjligheterna och väcker intresse för virtuell produktion-

splanering
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3 Problemformulering

3.1 Problemformulering

I dagsläget används en befintlig serie laborationsuppgifter som utvecklats av Dassault Systémes. Hu-

vuduppgiften i projektet är att utveckla nytt laborationsmaterial med en tydlig koppling till utrustningen i

PSL. Genom kopplingen till verkligheten, och mer handfasta exempel i laborationerna, ska kursdeltagarna

f̊a en djupare först̊aelse för programmets potential.

För att f̊a ytterligare insikt i vad som kunde förbättras i laborationsserien genomfördes en egen undersökning

där gruppen gjorde en enkät som 2013 års kursdeltagare fick besvara. I enkäten behandlades bland annat

fr̊agor om instruktionerna var lätta att följa, om de gav en klar bild av vad som skulle behandlas i laborationen

och om laborationerna gav en tillfredställande kunskapsniv̊a för framtida bruk av DELMIA. Fr̊agorna berörde

även huruvida de viktigaste delarna av programmet behandlades i materialet, om det var n̊agot som behövde

mer eller mindre fokus eller om n̊agot behövde göras om helt. Vidare efterfr̊agades vilka moment som bör

finnas kvar till den nya uppsättningen av laborationsserien. Enkäten finns bifogad som bilaga A.

Ett moment i projektet är att utforma laborationsserien p̊a ett pedagogiskt sätt, som f̊angar utövarens

intresse, samtidigt som den lär ut grundläggande funktioner och operationer i DELMIA. I detta moment

ing̊ar b̊ade att utveckla inneh̊allet i laborationerna, samt att utforma instruktioner till varje laboration p̊a ett

strukturerat sätt som underlättar inlärning för kursdeltagarna. Laborationerna kommer att vara baserade

p̊a cellen Low level of automation i PSL.

För att f̊a en bra struktur p̊a laborationerna krävs att filerna är lätt̊atkomliga och finns p̊a samma ställe.

De modeller som saknas konstrueras och samtliga filer struktureras i ett tydligt och lättförst̊aeligt system.

Detta sparar tid för kursdeltagarna d̊a de slipper leta efter filer.

Ett annat moment i projektet är att med hjälp av en film demonstrera hur montering i PSL kan se ut

i DELMIA. Denna skall visas för kursdeltagarna i syfte att ge djupare först̊aelse inför uppgiften. Filmen

återspeglar arbetsprocessen i det fysiska labbet och har även som syfte att väcka ytterligare intresse hos

kursdeltagarna.

För att kunna utforma laborationsuppgiften p̊a ett sätt som uppfyller ovanst̊aende krav, m̊aste projektgrup-

pen vara insatt i hur programmet DELMIA fungerar. Detta kommer åstadkommas genom deltagande p̊a ett

antal föreläsningar om programmet, samt genomg̊ang av befintligt laborationsmaterial.

3.2 Avgränsningar

En tillfredställande niv̊a av pedagogik anses säkerställas genom tester av laborationsmaterialet. Projektet

kommer inte kunna verifiera att en högre niv̊a av pedagogik uppn̊as.

Fokus i arbetet kommer att ligga p̊a att f̊a fram laborationsmaterial för den manuella delen i PSL, cell 1:

Low level of automation. Detta dels för att tiden inte räcker till för att modellera upp och göra laborationer

till hela PSL och dels för att detta är den del av processen som är mest relevant i utbildningssyfte för

institutionen för Produkt- och produktionsutveckling.
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4 Teori

4.1 CATIA

CATIA, Computer Aided Threedimensional Interactive Application, introducerades 1980 p̊a marknaden och

fick fort uppmärksamhet av b̊ade flyg- och bilindustrin. CATIA är ett programpaket för utveckling av

CAD/CAM-produkter, där man bygger upp prototyper virtuellt. I programmet analyseras och simuleras

prototyper för att verifiera designval och funktionsval p̊a alla delar i konstruktionen. Dagens utveckling av

nya produkter är komplex eftersom produkterna är utformade för väldigt varierande ändam̊al. Detta har lett

till att CATIAs metoder för enkel uppbyggnad av 3D-modeller och digitala analyser blivit mycket populära.

CATIAs flexibilitet gör det möjligt att skapa vilken 3D-modell som helst. Dessa modeller kan sedan ligga till

grund för olika sorters maskintekniska processer s̊asom smidning, maskinbearbetning och gjutningsprocesser.

CATIA är ett verktyg som kan användas för att till exempel kontrollera toleranser och göra kollisions-

analyser. Analyserna gör det möjligt kontrollera produkten innan tillverkning. (Dassault Systémes, 2013a)

4.2 DELMIA

DELMIA, Digital Enterprise Lean Manufacturing Interactive Application, är ett systerprogram till CATIA

som b̊ada är en del av Dassault Systémes produktportfölj. DELMIA är ett program som ger stöd att modulera

och planera en industriell tillverkning. Programmet ger fullgoda simulationer och produktionsplaneringar

virtuellt för att ge en överblick om blivande produktionsprocesser.

För att använda DELMIA krävs att virtuella produkter och layouts redan finns uppyggda i CATIA. Dessa

används för att simulera produktionssystem i DELMIA. Genom att analysera produktionssystemen kan

problem p̊a konstruktionen förutses, vilket ger en tidig möjlighet att korrigera dessa. Detta ger en högre

säkerhet när konstruktionen g̊ar ut i produktion. (Dassault Systémes, 2013b)
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5 Metod

5.1 Uppdelning av arbetsuppgifter

Till en början studerades de befintliga laborationerna för att f̊a grundläggande kunskaper om hur DELMIA

kan användas. När kandidatgruppen fick en bild av hur programmet och kursmaterialet fungerade planerades

det resterande arbetet. Kandidatgruppen delades in i tv̊a ansvarsgrupper. Den första hade främst ansvar

för arbetet som utfördes i DELMIA och CATIA. Till en början bestod det av att inventera vad som fanns

i form av CAD-filer samt vad som behövde mätas upp och sedan skapas i CATIA. Därefter gick arbetet

över till att skapa miljön och processerna i DELMIA. Den andra gruppen ansvarade för texten i det nya

labbmaterialet. Till detta hörde ocks̊a insamling och analys av studenternas åsikter. Gruppen gick igenom

och analyserade det befintliga laborationsmaterialet samt bestämde uppbyggnad och struktur för det nya.

Det var ocks̊a denna grupp som till en början hade ansvar för att skapa det första utkastet till rapporten.

De tv̊a grupperna arbetade parallellt men med mycket kontakt sinsemellan för att skapa det slutgiltiga

laborationsmaterialet. Rapporten reviderades och sammanställdes slutligen av hela gruppen.

5.2 Modellering av PSL

Kandidatgruppen hade vid projektets start tillg̊ang till stora delar av PSL modellerat i CATIA. Detta

användes som utg̊angspunkt för att rekonstruera PSL virtuellt. Vissa delar plockades bort för att ge en

tydligare bild av cellen Low level of automation, kring vilken arbetet skulle fokuseras. Därefter jämfördes

modellen med verkligheten, se bilaga F. Bland annat saknades en ställning med förvaringsl̊ador för material

(lego). Mått togs fr̊an den verkliga ställningen för att sedan kunna modellera upp den. Sist lades CAD-

produkten av ställningen in i CAD-filen av PSL.

5.3 Modellering av Växell̊adan

Den del av PSL som kandidatarbetet hade i uppgift att simulera var den som berörde monteringen av

en växell̊ada i lego. CAD-modellen av växell̊adan togs fram genom att studera den verkliga växell̊adan.

Måtten för de olika delarna hämtades med hjälp av standardiserade m̊att för legobitar (Cailliau, Robert,

2013). Måtten kunde även verifieras genom mätningar av den verkliga produkten, se figur 4, bilaga E. Allt

eftersom delarna blev klara sparades dessa som CAD-parts. När alla delar skapats, sammanfogades dessa

till en CAD-produkt, se figur 5, bilaga E. CAD-produkten importerades slutligen till DELMIA.

5.4 Filstruktur

CAD-products och CAD-parts, som skapades när växell̊adan och PSL modellerades, sparades i kandidat-

gruppens egna mapp. När alla CAD-filer var klara flyttades de till den redan existerade mappen för PSL,

vid namn CAD of PSL (PSL, 2013). Detta skapade en del fel med referenserna hos CAD-products som

uppst̊ar när filer flyttas runt, vilket gör att de f̊ar sina länkar ändrade. CAD-products försöker d̊a länka till

CAD-parts som inte finns där de ursprungligen fanns. De fel som uppstod vid flytten korrigerades.
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5.5 Montering av växell̊adan

När PSL och växell̊adan var uppbyggda och importerade till DELMIA var nästa steg att skapa förutsättningar

för att simulera monteringen av växell̊adan. I det befintliga laborationsmaterialet fanns instruktioner för

hur en monteringsprocess kan simuleras, men d̊a implementerat p̊a en annan produkt, som tidigare nämnts.

P̊a institutionen PPU p̊agick flera kandidatarbeten med anknytning till PSL. I ett av dessa kandidatarbeten

gjordes en tidsstudie av montering p̊a stationen Low level of automation, den med växell̊adan. Tre medlem-

mar i kandidatgruppen deltog i denna studie för att p̊a s̊a vis prova p̊a att montera växell̊adan p̊a stationen.

Vid tidsstudien användes en monteringsinstruktion för att instruera testpersonerna. Kandidatgruppen fick

tillg̊ang till denna samt en film som visade monteringen. Monteringsinstruktionen och filmen visade hur lego-

bitarna skulle sitta ihop för att bilda en växell̊ada. Med detta som utg̊angspunkt kunde arbetet fortsätta p̊a

ett ännu mer välförankrat sätt.

5.6 Filmen, en simulering i DELMIA

Vid skapandet av en film i DELMIA, behövs först en simulering. En s̊adan skapas av användaren genom

att ladda upp önskade objekt i programmet, och sedan tilldela dessa objekt rörelser. Objekten i detta fall

var, som tidigare nämnts, av kandidatgruppen modellerade delar till en befintlig växell̊ada i lego. Rörelserna

skapades med muspekaren och det var även nödvändigt att ta hjälp av ett koordinatsystem för att f̊a

precisa positioner p̊a objekten. Rörelserna skapades utifr̊an de monteringsanvisningar till växell̊adan som

tillhandah̊allits gruppen och återgavs sedan i en simulering. Antal rörelser och längden i tid hos varje rörelse

bestämmer simuleringens längd. Banorna längs vilka objekten rörde sig var grönmarkerade och gömdes av

estetiska skäl. Rörelserna och simuleringen gjordes med det virtuella PSL som miljö.

Funktionen ”Video. . . ” användes för att spela in den önskade simuleringen. Under inställningarna till denna

funktion bestämdes bl.a. bakgrundsmiljön till inspelningen. Simuleringen spelades in i ”document window”

vilket innebär att samtliga ikoner och menyer p̊a skärmen inte syns under inspelningen. Processträdet gömdes

även manuellt. Tilläggas bör att inspelningen även tar med åsk̊adningsvyn i realtid under inspelning. Denna

funktion användes med fördel för att belysa monteringsstationen och fokusera p̊a växell̊adan.

Kvaliteten p̊a filmen bestämdes även under inställningar genom att antal bilder per sekund valdes. Fler

bilder per sekund ökar kvaliteten hos filmen, men ökar även filmens storlek. Formatet p̊a inspelningen valdes

till ”still image capture”. Med detta format sparas simuleringen i konsekutiva bilder. Det andra alternativet

var att spela in filmen direkt i DELMIA. Denna metod provades och resultatet blev en film med l̊ag kvalitet

samt hack och fördröjningar i uppspelningen. Därför användes formatet ”still image capture” där antal

erh̊allna bilder blev längden p̊a simuleringen i sekunder multiplicerat med det förinställda antalet bilder per

sekund.

VirtualDub är ett program som kan konvertera en serie bilder till en spelfilm. Programmet är gratis och

en snabbguide(Bentley, 2013) till hur detta kan användas tillhandahölls av handledare Jonatan Berglund.

Följaktligen skapades filmen ur bilderna och justerades efter önskad hastighet.
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5.7 Enkät

För att f̊a en bättre bild av vad kursdeltagarna, som gick kursen 2013, tyckte behövde ändras, gjordes en

kompletterande enkät som skickades ut. Enkäten ställde mer specifika fr̊agor om vad som ans̊ags vara fel

med det befintliga materialet, och vad som kunde beh̊allas vid utvecklingen av nytt laborationsmaterial, se

bilaga A. Informationen som samlades in togs i beaktning.

5.8 Utvärdering av befintligt material

Förstudier genomfördes av det befintliga laborationsmaterialet. Materialet analyserades och varje labo-

rations inneh̊all dokumenterades. Därefter utvärderade gruppen de olika momenten utifr̊an vad tidigare

studenter framfört. Det var även intressant för gruppen att fastställa vilka moment som kunde användas i

monteringsprocessen för växell̊adan. En diskussion fördes kring hur det nya materialet kunde utformas efter

de nya förutsättningarna. Med nya förutsättningar menas främst arbetsstationen som överg̊att fr̊an att i det

befintliga materialet vara en enkel arbetsplats, till att i det nya materialet vara linan i PSL. Även bytet till

en ny produkt förändrade förutsättningarna för utformandet av laborationsmaterialet.

Utvärderingen l̊ag som grund för beslutsfattande om vilka moment som skulle beh̊allas och vilka som kunde

plockas bort. En lista fastställdes över viktiga moment som skulle ing̊a och hur de skulle fördelas p̊a de olika

laborationerna. Detta blev utg̊angspunkten för det fortsatta arbetet. En strukturmall skapades ocks̊a för

det nya materialet utifr̊an vad som framkommit i enkäten och kursutvärderingen. Denna mall behandlade

laborationsmaterialets layout, Se exempel laboration 1 i bilaga D.

5.9 Skapande av nytt laborationsmaterial

Arbetet med framtagning av det nya laborationsmaterialet genomfördes i tv̊a steg. Det första steget var

att skapa ett utkast. Detta gjordes i strukturmallen med hjälp av listan över de steg som skulle ing̊a i

det nya materialet. Dessa steg beskriver hur momenten genomförs. Flera av stegen i det ursprungliga

laborationsmaterialet följdes när det nya materialet togs fram. Instruktionerna skrevs om s̊a att de blev

kortare och tydligare. De modifierades ocks̊a för att stämma överens med hur växell̊adan monteras.

När utkasten var färdigställda gjordes en genomg̊ang för att säkerställa att det inte fanns n̊agra skillnader vad

gäller struktur i materialet. När skillnader upptäcktes diskuterades dessa med de andra utkastsförfattarna.

Därefter ändrades alla labbar s̊a att de hade samma struktur.

Det andra steget innebär att laborationsmaterialet skulle vidareutvecklas. Den grupp som byggt upp PSL

i DELMIA gick igenom utkasten av laborationerna för att se om dessa var lätta att följa och först̊a. När

gruppen gick igenom laborationerna kommunicerade de kontinuerligt med den i gruppen som skrivit respek-

tive utkast. I utkasten fanns anteckningar för var det var nödvändigt att komplettera med bilder och vad

dessa bilder skulle inneh̊alla. När utkasten av laborationerna gicks igenom kompletterades de med bilder och

annat som saknades eller behövde ändras vad gäller text och layout.
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6 Resultat

6.1 Enkät

Nio av femton studenter svarade p̊a enkäten som skickades ut. Av svaren framkom att de flesta tyckte

att det tidigare laborationsmaterialet gav tillräckliga kunskaper om hur DELMIA kan användas. Därför

behölls större delen av inneh̊allet i det tidigare materialet. Vad gällde strukturen var svaren blandade.

33% tyckte inte att materialet gav en bra bild av vad laborationerna skulle behandla innan de p̊abörjades.

Kandidatarbetet lade s̊aledes stor vikt vid att det nya materialet skulle ge en bra först̊aelse för vad som

skulle hända i varje laboration. De flesta tyckte att materialet var lätt att följa men en del uttryckte att det

var ostrukturerat och sv̊art att följa. Därför blev m̊alsättningen att fler i framtiden ska tycka att materialet

är lätt att följa. Fullständiga fr̊agor och svar finns i bilaga B. Genom denna undersökning ans̊ags första

delsyftet vara uppn̊att.

6.2 Laborationsmaterialet

Laborationsmaterialet som togs fram best̊ar av fem laborationer. Alla är skapade i Power Point och följer

samma layout. D̊a kursen där materialet ska användas ges p̊a engelska har ocks̊a det nya materialet skrivits

p̊a engelska. De största skillnaderna fr̊an det gamla materialet är att produkten bytts ut mot en växell̊ada

av lego, miljön har ändrats till PSL och att vissa moment valts bort. De moment som strukits är s̊adana som

antigen varit överkurs eller inte ansetts tillföra monteringsprocessen n̊agot större värde och därför bedömts

som irrelevanta för materialet. Hela sista laborationen i det gamla materialet togs därför bort. Andra

moment som valdes bort var create annotations, create text messages, create hyperlinks fr̊an laboration 4.

Fr̊an laboration 6 togs create HTML-documentation bort. Efter dessa ändringar slogs laboration 4 och 6

ihop till en och samma. Denna lades i slutet av serien.

Layouten som alla nya laborationer följer är uppdelad i steg. De är delmoment till slutresultatet av labo-

rationen. Antalet steg varierar mellan tre och sex. I början av varje steg finns en inledning som berättar

vad som kommer att behandlas. Inledningen inneh̊aller ocks̊a en översikt över alla steg i laborationen, deras

namn samt vilket av dem som utövaren strax skall p̊abörja. Varje steg best̊ar av en numrerad genomg̊ang

av ett moment illustrerat med bilder. För att ge en bättre först̊aelse g̊ar de flesta av stegen först igenom

ett moment för att sedan l̊ata användaren applicera det p̊a projektet med växell̊adan. Laboration 1 finns

bifogad som bilaga D för att demonstrera layouten. Nedan följer en beskrivning av varje laboration och med

dessa anses även det andra delsyftet vara uppn̊att.

6.2.1 Laboration 1

Laborationen g̊ar igenom allt som behöver göras innan en process kan skapas. Det första steget är att ställa

in de grundläggande alternativen för DELMIA s̊a de passar den typ av process som senare skall skapas. Sedan

ska en projektkatalog skapas, vilken inneh̊aller alla produkter som ska används i processen. Till detta hör

arbetsstationen och växell̊adan. En katalog kan användas till flera liknande processer. För andra processer

kan katalogen även inneh̊alla verktyg.
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För att kunna skapa en miljö i DELMIA behövs först ett golv. När golvet är p̊a plats kan arbetsstationen

byggas upp. Därefter kan produkten läggas in i miljön.

6.2.2 Laboration 2

I den andra laborationen skapas själva processen, det vill säga grunden till det som sedan kommer bli rörelser.

Det första steget är att skapa ett processbibliotek för de olika aktiviteterna som kommer användas. Därefter

läggs aktiviteterna till i ett processträd, en aktivitet för varje rörelse som ska ske i simuleringen. När alla

aktiviteter skapats ska de arrangeras i rätt ordning. Detta görs med hjälp av funktionen ”Pert Chart”. I

funktionen länkas aktiviteterna med varandra i den ordning de ska äga rum. När det är färdigt avslutas

funktionen vilket tar användaren tillbaka till processträdet. Därefter länkas aktiviteterna till de delar av

produkten som varje aktivitet berör. Slutligen ska processen verifieras för att se s̊a att den är fullständig,

detta görs genom provkörning av laborationen.

6.2.3 Laboration 3

Laborationen förklarar hur rörelser skapas i aktiviteterna samt hur de kan förändras och tas bort. När alla

rörelser finns visas hur processen simuleras.

6.2.4 Laboration 4

Denna laboration g̊ar igenom olika sätt att analysera en process p̊a. Avsnittet behandlar sex olika analysme-

toder. Den ena är en s̊a kallad kollisionsanalys, vilken talar om ifall n̊agot krockar eller kolliderar under

monteringen. En annan typ av analys kan användas för att mäta olika m̊att. Det är ocks̊a möjligt att

analysera detaljer i genomskärning vilket förklaras i laborationen. Vid en montering kan utrymmet mellan

olika detaljer vara intressant. Därför kan analyser göras där minimalt avst̊and anges för att sedan tala om

ifall utrymmet mellan tv̊a detaljer är för litet under n̊agot skede av processen. Den avslutande metoden är

lite annorlunda mot de andra d̊a ett Ganttschema används. Det skapas för att analysera ordningsföljden

och monteringstiden.

6.2.5 Laboration 5

Den sista laborationen behandlar olika funktioner som är bra att använda d̊a en simulering skall presenteras.

Till dessa hör en funktion som gör det möjligt att hoppa till ett specifikt skede i monteringen för att

analysera detta närmare. En annan användbar funktion kan användas för att lägga in olika åsk̊adningsvinklar

i processen s̊a att vyn flyttas till önskat läge under simulering. Det g̊ar ocks̊a att lägga in pauser och

fördröjningar om det är önskvärt att stanna simuleringen i ett visst skede. Laborationen behandlar även

hur man g̊ar tillväga för att skapa en film.
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6.3 CAD-filerna

6.3.1 PSL

Laborationsmiljön i PSL saknade vissa delar för att kunna bygga upp cellen Low level of automation. Totalt

skapades tv̊a bildskärmar, tv̊a lampor, l̊ador för komponenterna och en ställning med diverse kringutrustning,

se Figur 2.

Figur 2: PSL uppbyggt i CATIA.

6.3.2 Växell̊ada

D̊a alla delar saknades till växell̊adan skapades dessa i CATIA. Sammanlagt skapades tolv olika komponenter,

av vilka sex stycken duplicerades. Dessa sammanfogades sedan till den slutgiltiga växell̊adan. Den korta

axeln samt drivhuset sammanfogades till en del för att spara tid vid konstruktionen av växell̊adan, se Figur

3. En lista över komponenter finns i bilaga E.

6.4 Filstruktur

De nya CAD-filerna som skapats strukturerades upp i ett nytt mappsystem, där endast filer som berör

laborationsserien finns. De redan existerande filerna som hör till serien skulle ocks̊a struktureras men detta

kunde ej genomföras d̊a det ans̊ags för riskabelt att förstöra de olika CAD-produkternas referenser till CAD-

parts.

6.5 Filmen

En film skapades under projektet för att visa monteringen av växell̊adan i lego. Filmen visar hur alla

legobitar flyttas fr̊an l̊adorna de ursprungligen l̊ag i till paletten p̊a linan i den ordning de ska monteras.
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Figur 3: Växell̊adan sammansatt som CAD-produkt.

Filmen speglar monteringen som sker manuellt i PSL och härmed är det tredje och sista delsyftet uppn̊att.
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7 Diskussion

7.1 Diskussion

Kandidatgruppen är nöjd med det nya laborationsmaterialet och den film som gruppen skapat. Strukturen

är nu lättare att följa, och har en tydlig koppling till PSL. Målen som var satta har blivit uppfyllda. Det finns

en tydlig skillnad fr̊an föreg̊aende laborationer, där materialet var upprepande och vissa delar överflödiga.

Genom ett väl strukturerat arbetssätt fick inte bara gruppen en bra först̊aelse för arbetsuppgiften utan även

fördjupad kunskap inom CATIA och DELMIA. Fr̊an planeringsstadie till slutresultat har gruppen lärt sig

hur man skapar ett projekt och hur problem som uppst̊ar p̊a vägen kan hanteras.

7.1.1 Enkät

Alla kursdeltagare svarade inte p̊a enkäten. Detta skulle kunnat ge en missvisande slutsats när gruppen g̊ar

genom svaren. Dock var svaren fr̊an kursdeltagarna v̊aren 2013 lika svaren p̊a förg̊aende års kursenkät. De

kompletterande fr̊agorna gav ytterligare stöd i vidareutvecklingen av det gamla materialet.

7.1.2 Det nya laborationsmaterialet

Vid utvecklandet av det nya materialet fastslog gruppen att en genomg̊ang av teoretiska instruktioner med

stöd fr̊an punktlistor och bilder är adekvat för att först̊a laborationera. Resultatet är en laborationsserie

som är lättare att följa och inneh̊aller alla vitala delar.

Ytterligare en aspekt som gjort materialet mer givande är att det är kopplat till slutprodukten som skall

skapas. Alla steg är applicerade p̊a växell̊adan och PSL. Laborationsdeltagarna kan nu, till skillnad ifr̊an

innan, sätta laborationen i perspektiv mot verkligheten. Denna verklighetsanpassning var ett viktig m̊al för

gruppen genom hela arbetet. Gruppen tycker att denna förankring i verkligheten har underlättat arbetet.

7.1.3 Val av moment

Anledningen till att en del moment ströks var för att kunna skapa ett mer fokuserat laborationsmaterial

och beh̊alla laborationsdeltagarnas intresse genom hela materialet. De moment som ströks ur laboration

4 och 6 hade en otydlig koppling till resterande moment i materialet. Dessa var även sv̊ara att använda

i monteringsprocessen av växell̊adan. Däremot är de inte oanvändbara men det krävs en mer komplex

process för att de ska komma till sin rätt. D̊a laborationsmaterialet bara ska ge en inblick i hur DELMIA

kan användas ans̊ags de som överkurs. Hade fallet inte varit s̊a hade produkten behövt anpassas s̊a att

momenten hade kunnat appliceras i processen. Gruppen valde allts̊a att anpassa momenten efter produkten,

och inte tvärt om.

När momenten som nämndes ovan strukits, ans̊ag gruppen att laborationerna hade en rimlig bredd och

sv̊arighetsgrad. Det är möjligt att det finns funktioner som hade fungerat bättre i materialet men dessa är

i s̊a fall okända för gruppen. Gruppen har valt att inte fördjupa sig i funktioner utöver de som finns i det

ursprungliga materialet.
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7.1.4 Varför PSL och växell̊ada?

Fr̊an början gav handledaren ett förslag p̊a produkt som gruppen kunde använda till laborationsmaterialet.

Produkten hade för f̊a delar och saknade verklig koppling till en monteringsmiljö. Efter diskussion mellan

gruppen och handledare valdes ett förslag som gruppen kommit fram till. Valet var miniatyrbilen som var

knyten till en verklig monteringsmiljö, nämligen monteringslinan i PSL. Därför var det intressant att utforska

möjligheterna med denna.

Till en början var m̊alet att skapa karossen och tillämpa denna i laborationsserien. Själva monteringen av

karossen görs av robotar. D̊a gruppen presenterade förslaget för examinator och handledare ans̊ag de att

en manuell monteringsprocess var att föredra. Växell̊adan var s̊aledes ett bättre alternativ att arbeta med,

d̊a den monteras manuellt. Genom att ha en manuell monteringsmiljö kan studenten hantera den fysiska

produkten och titta p̊a monteringsintstruktionerna. Därigenom skapades en koppling mellan laborationerna

och en verklig miljö.

7.1.5 Filstruktur

Under konstruktionen av PSL upptäcktes problem med filerna som byggde upp miljön. Filerna var antingen

försvunna eller lokaliserade p̊a fel plats. Detta gav felmeddelanden som gruppen till en början inte visste

hur de skulle hantera. Gruppen löste till slut felet genom att radera filer i programmet som inte kunde

hittas. Problemet orsakade tidsförluster. Detta motiverade m̊alsättningen att gruppen skulle skapa en

bättre filstruktur.

Under arbetets g̊ang flyttades filer vilket gjorde att flera felmeddelanden uppstod. Detta p̊a grund av att

CAD-products skapar referenser till CAD-parts. Dessa ändras inte alltid om filer flyttas. Allt eftersom

arbetet fortgick märktes detta allt mer. För att förenkla situationen beslutade gruppen att vänta med att

flytta filer tills arbetet var klart, och d̊a flytta alla filer samtidigt. Gruppen valde allts̊a att skjuta upp

problemet med referenserna till slutet av arbetet, för att d̊a kunna ta hand om dessa fel samtidigt.

7.1.6 Tidsaspekt

Det befintliga materialet var sju stycken tv̊atimmars laborationer som skulle g̊as igenom de första veckorna.

Det var d̊a tänkt att gruppen skulle g̊a igenom en till tv̊a laborationer i veckan. Detta tog dock mycket

längre tid än väntat vilket gjorde att arbetet krävde ett annat upplägg för att h̊alla sig inom tidsramen.

Dessutom ans̊ag inte gruppen att alla medlemmar behövde kunna allt i alla laborationer. Det räckte istället

att dessa lästes igenom av n̊agra gruppmedlemmar för att ge en överblick av vad laborationerna gick igenom.

De andra fick en överblick d̊a de gick igenom utkasten till det nya laborationsmaterialet och arbetade med

DELMIA. Att dela upp arbetet p̊a detta vis var lyckat och sparade gruppen mycket tid, d̊a arbetet blev mer

effektivt.

Tidsaspekten vad gällde laborationerna var ocks̊a en avvägning gruppen hade i åtanke under arbetets g̊ang.

När upprepningarna av momenten tagits bort och filstrukturen förbättrats, ans̊ags det att den tidigare

rekommenderade tiden p̊a tv̊a timmar per laboration är tillräcklig för de nya laborationerna. Gruppen tog

inte tiden för varje laboration, men arbetet gav en uppfattning att varje laboration inte överstiger tiden.
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Slutsatsen gruppen kan dra av detta är att de nya laborationerna är mindre tidskrävande än de gamla. De

nya laborationerna ligger p̊a en relativt jämn niv̊a tidsmässigt.

7.1.7 Filmen

Under skapandet av filmen uppstod en del problem. Simuleringen fungerade utmärkt men vid inspelningen

av denna gick programmet trögt, speciellt d̊a kameravinkeln justerades samtidigt. Detta berodde sannolikt

p̊a datorn som användes, vilken var n̊agot daterad. Uppspelningen av filmen visade p̊a samma problem d̊a

den var trög och hackade. Detta åtgärdades genom att under inspelningen spara simuleringen i bilder.

För att konvertera bilderna till en film användes Virtualdub. Programmet är inte lika krävande för datorn.

Dock hade kandidatgruppen ingen tidigare erfarenhet av programmet och fick därför lära sig hur det funger-

ade. En användarguide fanns att tillg̊a online och denna var lätt att följa. Metoden att konvertera bilder

till film visade sig lyckosam d̊a filmen blev snygg och rullade p̊a utan hack. Den blev dock väldigt stor,

och behövde därför komprimeras avsevärt. Med en mer kraftfull dator kunde detta problem antagligen ha

undvikits, vilket ocks̊a skulle sparat tid och arbete för gruppen.

7.2 Rekommendationer

I det fortsatta arbetet med laborationsmaterialet bör laborationerna testas mer utförligt för att säkerställa

deras kvalitet. Hur l̊ang tid varje laboration tar bör även undersökas närmare för att säkerställa att man

kan genomföra en laboration p̊a utsatt tid.

Efter att laborationsmaterialet har använts i en kurs, bör en enkät skickas ut till deltagarna för att undersöka

hur de upplevde det nya materialet.

Vidare utveckling kan vara att inkludera hela PSL i 3D-världen, eller att lägga in ett ergonomiskt moment i

cellen Low level of automation. Ett exempel p̊a detta kan vara att lägga in en virtuell hand eller människa vid

monteringen. Det g̊ar även att använda de filer och den miljö, som skapats i samband med kandidatarbetet,

i andra uppgifter och projekt knutna till PSL.

N̊agot som rekommenderas för andra arbeten i b̊ade CATIA och DELMIA är att ha samma filstruktur fr̊an

början till slut s̊adant att filer ej behöver flyttas.
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A Enkät

Virtual process planning

We are a group of students from Mechanical engineering and Automation and Mechatronics, working on

our bachelor thesis, with the goal of constructing new material for the DELMIA lab assignment in Virtual

process planning. The new material is going to be based on the equipment in the Production Planning

Laboratory. With your help we would like to evaluate the current lab material, through this short survey.

1. Did you think the tutorials for Delmia were easy to follow?

2. Did you feel that the material gave you a clear picture of what the lesson was going to cover? - If

not, what would you change?

3. Did the course give you enough knowledge for your eventual future use of Delmia?

4. Did the tutorials cover the essential parts of Delmia?

5. What should be kept in the material for next year’s course?

6. Did any part need more/less focus than it got in the lessons? - If yes, which part and why?

7. Is there anything else you would like to change in the course material?

We are also conducting an evaluation on out upcoming lab, later this spring. Make sure to look for further

information about this. Your input is important for our project. Thank you for your help!

19



DELMIA Laboration

Please give a more detailed review of the Delmia PPR Task in questions 23-29. This will be used by a group of students
do develop next years lab material. 

This is a message from them:

"We are a group of students from Mechanical engineering and Automation and Mechatronics, working on our bachelor
thesis, with the goal of constructing new instructions for the DELMIA lab assignment in Virtual process planning. The
new instructions are going to be based on the equipment in the Production Systems Laboratory. With your help we would
like to evaluate the current lab instructions, through this short survey.

We are also conducting an evaluation on out upcoming lab, later this spring. Make sure to look for further information
about this. Your input is important for our project.

Thank you for your help!"

23. Did you think the tutorials for Delmia were easy to follow?

9 svarande

Excellent» 2  22%

Very Good» 2  22%

Good» 3 33%

Poor» 1  11%

Very Poor» 1  11%

Genomsnitt: 2.66

- I had no issues following the instructions and the tutorials at all.» (Excellent)
- Unstructured and Hard to follow» (Poor)

24. Did you feel that the material gave you a clear picture of what the lesson was going to cover?

9 svarande

Yes» 6 66%

No» 3  33%

Genomsnitt: 1.33

- I want to know the final result before the lesson» (No)

25. Did the course give you enough knowledge for your eventual future use of Delmia?

- Not as in I could work with it but it gives a nice base, something to build on.»
- Yes»
- no»
- No, Since the purpose of this lab was to familiarize the software for the students. »
- It taught the basics »
- no»

26. Did the tutorials cover the essential parts of Delmia?

- Hard to say right now, since I don"t know what I haven"t learned about Delmia yet. I"d say probably most of them
though.»
- Yes»
- yes»
- I don"t think so, since we only used one function of Delmia which was assembly.»
- Yes »
- no»

B Enkätsvar



27. What should be kept in the Delmia Lab material for next year"s course?

- I thought it was a good experience but then again I"m usually extremely fast with labs, but I"d say keep all of it.»
- Overall the materials was enough for the purpose but if there is going to be any changes in the purposes of the lab then
the materials should be changed.»
- Manipulation and situation»

28. Did any part of the Delmia lab need more/less focus than it got in the lessons?

6 svarande

Yes» 1  16%

No» 5 83%

Genomsnitt: 1.83

29. Is there anything else you would like to change in the course material?

6 svarande

Yes» 1  16%

No» 5 83%

Genomsnitt: 1.83



Nedan är ett utplock från kursenkäten vt 2012 och redovisar bara de frågor och 
svar som rör laborationerna i DELMIA. 
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DELMIA V5: COMPUTER LAB 1

Create the working environment

Introduction to DELMIA V5

Welcome to this guide, which will teach you how you can use DELMIA as a 

tool in process planning. DELMIA is a manufacturing process planning and 

simulation software. It can be used to verify an assembly sequence and try 
different ways to assemble a product. Doing this virtually, before 

implementing it in reality can save a lot of time and money.

DELMIA uses CAD-parts and –products to build the environment and then 

to create the assembly simulation. All the parts and products that will be 
used in this guide will be provided to you at 

\\129.16.63.246\ps\Public\PSL Catia\CAD of PSL. Hence you do not 

have to create them yourself.

Introduction to DELMIA V5

In this guide you will build the Production Systems Laboratory (PSL) that exist in the 
PPU-lab and simulate its assembly process. The pictures below shows the PSL in real life 
and how it can look in DELMIA.

Step 1: Set options

The Dassault Systemes family of 
software offers unprecedented 
power and flexibility to its users. 
However, because of this ability, the 
software must be configured to fit 
the user’s needs. The first step in 
Creating the Working Environment is 
to set the Tools/Options in the 
software.  In this section, you will 
learn how to set some of the options 
that are especially useful for DPM 
Assembly projects. 

1.Set Options.

2.Create Project Catalog.
3.Create Plant floor
4.Insert Resources
5.Insert Product.

Use the following steps to Create the 

Working Environment:

Step 1: Set options (1/2)

1. Open DELMIA V5

a. Select Tools

b. Select Options

When in the Options dialog box, 

notice the nodes on the left and tabs

along the top as you access each node. 

Step 1: Set options (2/2)

2. Use the table below to set the options as instructed

Node Tab Option  Setting_________________________

General General Turn Off Automated backup

General Document Other Folders= map to the location where the 
software is installed and also to the location where 
training data may be loaded. 

Display Tree Manipulation Turn on Automatic scroll

Display Navigation Turn on Display Manipulation Bounding box

Turn on Gravitational Effects to z axis

Parameters & Measures Report Generation Input XSL = map to the location where the software is 
installed 

Output Directory = map to the location where you 
want to have output files stored.  

Infrastructure/ Product Structure Cache Management Activate Work with the Cache System

Digital Process for Mfg Tree Activate Applicative Data

Digital Process for Mfg Libraries ADD Libraries = map to the location where the 
training data is stored and also to any other locations 
containing libraries you may wish to use. 

Digital Process for Mfg Gantt Chart Activate “Compare Roll up time of Parent 
with Calculated time”  (selected from drop 
down menu) 

Note: You need to restart DELMIA for some of the changes to take effect

D Laboration 1
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Step 2: Project catalog

A project catalog allows the 
user to create a catalog of 
commonly used items that will 
be more efficient to access than 
going to multiple locations or to 
a large repository of objects.  It 
stores these commonly used 
items (or their links) in a single 
location for easy accessibility.

� In this section, you will learn 
how to Create a Project 
Catalog. 

Use the following steps to Create 

the Working Environment:

1.Set Options.
2.Create Project Catalog.
3.Create Plant floor
4.Insert Resources
5.Insert Product .

Step 2: Project catalog (1/4)

1. Create a new catalog document.

a. Click Start > Digital process for manufacturing > Assembly process simulation

b. Click File > New and select Catalog document from the list. 

c. Rename Chapter.1 to PSL-Lab.

d. Add an additional chapter by selecting Add Chapter from the Chapter toolbar icon or Insert menu 
and name it Conveyor Line by typing it in the Chapter definition window.

e. Repeat the procedure and name the following chapter Product. 

1b.

Step 2: Project catalog (2/4)

2. Create families  to the chapters.

a. Add the first family to Conveyor Line by highlighting the chapter and then clicking Add family from 
the Chapter toolbar icon or Insert menu. 

b. Name the family Line and leave the Type as Standard. 

c. Add an additional family to the chapter Conveyor Line and name it 

d. Work station.

e. To the chapter Product add the following family: Engine parts

2a.

Step 2: Project catalog (3/4)

Chapter Family Components________________________________________

Conveyor Line Line _PSL_Environment_VPP.catPROD,  palett.catPART
Conveyor Line Work Station Asemb_Stat.catPROD (located in the subfolder Workstation)
Products Engine parts GearBox.catPROD (located in the subfolder Gearbox)

3a.

3. Add components to the families.
a. Add the first component to Line by highlighting the family and then clicking 

Add component from the Data toolbar icon or Insert menu.
b. When the Description Definition window opens, click on Select document

and navigate to where the data-files are located. Select the requested 
component (see below) and click Open. The Description Definition window 
returns with the Type set to Document and the file path is listed in the File 
Name-line. 

c. To see the geometry of the chosen component click on the Preview tab. 
d. Repeat the Add component-procedure for all of the components in the 

following table. 

Step 2: Project catalog (4/4)

4. Add link to another catalog.

a. Highlight the chapter Link to Nuts/Bolts/Screws catalog and then click  
Add Link to Another Catalog.

b. Click on Select and navigate to C:\Program Files\Dassault
Systemes\B20\intel_a\startup\components\MechanicalStandardParts\

ISO_Standards

c. Select ISO.catalog and click on Open.

d. Note: You have now linked the folder to a ISO standard catalog. You 
can view the parts by clicking launch, then swap to the preview tab.

e. You are now done with your project catalog. Save it by clicking File > 
Save As and name it MyProjectCatalog.

4a.

Step 3: Create a plant floor

A plant floor is used to simulate the area 
of the facility, how it is used or how it 
can be used. This is helpful if you are 
planning to rearrange the layout of your 
production facility.

� In this section, you will learn how to 
Create a Plant floor, and how to input 
it into a DPM Assembly Process 
Simulation. 

Use the following steps to Create 

the Working Environment:

1.Set Options.
2.Create Project Catalog
3.Create Plant floor
4.Insert Resources
5.Insert Product .
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Step 3: Create a plant floor (1/2)

1. Create the floor.

a. Click Start > AEC Plant > Plant layout.

b. When workbench opens, click the Area icon on the 
Plant Layout toolbar. 

c. In the Area Creation window, make sure that the 
Create-button is in its default position: 
Rectangular-Location. 

d. Set area size to 

� X: 7 000 mm

� Y: 12 000 mm

� Height: Can be ignored

For DPM Assembly projects, the facility design is created in AEC Plant Layout, saved as a resource, and 
then inserted  into the environment under construction.  This example will show the creation and insertion of 
a plant floor only.

1b.

1c.

Step 3: Create a plant floor (2/2)

2. Open the DPM Assembly Process Simulation workbench.

a. Click on Insert > Insert resource or the Insert Resource icon on the Activity Management toolbar.

b. Navigate to where the plant floor is located and import it. 

c. Save project as Lab1Step3.CATProcess.

e. Move the mouse into the main screen workspace. A green box with the 
coordinates indicated moves around with the mouse. Positioning the mouse 
at Coordinates 0,0,0 puts the item in the center of the world. Click to set.

f. Click on Fit All to zoom out.

g. Right click on Product1 in the PPR-tree and select Properties. 
h. In the dialog box change the Part Number to a suiting name and then 

click Apply > OK.
i. Save the file where you can easily find it and then close the AEC Plant 

layout workbench.

1f.

Step 4: Insert resources 

Insert resources is used to create the 
working environment in Delmia V5. By 
using the created Project Catalog
importing resources is made quick 
and easy

� In this section, you will learn how to 
insert resources with a Project 
Catalog.

� Move and rotate parts in the 
world.

Use the following steps to Create 

the Working Environment:

1.Set Options.
2.Create Project Catalog
3.Create Plant floor
4.Insert Resources
5.Insert Product .

Step 4: Insert resources (1/5)

1. Open Lab1Step3.CATProcess.

2. Import the catalog.

a. Go to the Insert menu or locate the Activity Management 
toolbar and click on the Catalog browser. The Catalog
browser menu will open the last catalog used. 

b. Select the browse another catalog icon at the far right 
to navigate to the desired catalog or library. 

c. Locate MyProjectCatalog.catalog.

d. To insert resources from catalog, simply left click on the 
desired resource and left click in the world. 

3. To directly insert a resource.

a. Select the Insert Resource function from the menu or the 
icon on the Activity Management toolbar. 

b. Once the desired resource is located click Open to put it 
in the world. One instance of the resource will now 

appear at the location 0,0,0. 

3a.

Step 4: Insert resources (2/5)

4. Import following resources: 

a. _PSL_Environment_VPP

b. Palett_VPP

c. Workstation

5. Positioning resources in the world.

� It is best to move each item to its approximate 

final position before inserting another resource.  

For items intended to be placed relative to another

item (like a plant floor), at least one coordinate will 

be critical.  For the plant floor example, all items 

must be at “0 on the Z axis.”  

There are two ways to accomplish this.

Step 4: Insert resources (3/5)

6. Using the Bounding box.

a. The item can be manipulated using the the bounding box. This 

feature allows an item to be moved anywhere in the world 

according to the Grid step size, default setting is 100mm. 

b. To move an object with the bounding box highlight the item in the 

PPR tree and then click and hold one of the green lines 

surrounding the item. Now the item can be moved in the direction 

of the line. 

c. When in position let go of the cursor, if needed click and drag on 

a different line of the box to move the item that direction.
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Step 4: Insert resources (4/5)

7. To move an object using the Compass:

a. Right click on the compass and select Snap Automatically 

to Selected Object from the menu.

b. Click on the object to be manipulated. The compass 

moves to the object and the bounding box appears. 

c. Grab and hold the axis of the compass that will move or 

rotate the object in the desired direction. 

d. Repeat the grabbing and moving until the object is in the 

desired location. 

e. Right click on the compass and click Snap Automatically 

to Selected Object again to toggle off this function and 

permit the compass to be moved back into the world. 

Step 4: Insert resource (5/5)

8. Rightclicking the Compass and clicking Edit

will open the Parameter for Compass 
Manipulation dialog box, the precise 
location can then be set. 

9. An object can be toggled between hidden 
and shown in the world by right clicking it 
in the PPR tree and clicking HIDE/SHOW.  

10. To remove an object from the world 
highlight the object in the PPR tree and 
then click the Remove from PPR icon in the 
PPR Tools toolbar.

11. Save the process as Lab1Step4.CATProcess 

10

Step 5: Insert product

Insert product is used to try out 
different ways of assembling 
the end product. 

� In this section, you will learn 
how to insert products.

� Another way to move and 
rotate parts in the world by 
using the tool Snap Resource.

Use the following steps to Create the 

Working Environment:

1.Set Options.
2.Create Project Catalog
3.Create Plant floor
4.Insert Resources
5.Insert Product 

Step 5: Insert product (1/4)

1. Open Lab1Step4.CATProcess.

2. Insert the Products into the world.

a. Select Insert Product from the menu or the icon on the 

Activity Management toolbar.

b. When the file selection dialog box opens, navigate to and 

open the file GearBox.CATProduct.

c. The product will be inserted at coordinates 0,0,0. Right 

clicking the product in the PPR tree and clicking Reframe on

will orient the perspective to the product location. 

d. Move the product with the Compass or the Bounding box to 

the palett on the work station. 

1a.

1a.

Step 5: Insert product (2/4)

3. Positioning the products in the world. Define the plane to be 
snapped to.

a. Highlight the GearBox. CATProduct from the ProductList in 

the PPR tree. 

b. Select the Snap Resource function from the Layout Tools 

toolbar. 

� The icon will turn orange when activated.

c. When the Define Reference Plan (From) dialog box 

opens leave the default Define Plane mode selection. 

d. Position the mouse pointer on the bottom of the product so 

that the indicator points downward.  

� This is the surface that will be snapped to the table top. 

e. Click to set the indicator on the surface.

f. Click OK in the dialog box.

3b.

Step 5: Insert product (3/4)

4. Positioning the products in the world. Define the plane to be 
snapped to.

a. When the Define reference plane (from) dialog box 
closes, select an object to receive the snapped object.

b. Select the Palett_VPP from the PPR tree 

c. When the Define Reference Plane (To) dialog box 
opens, leave the default Define Plane mode selection. 

d. Position the mouse pointer on top of the table where you 
want the product to be located with  the white plane 

indicator pointing upward.  

� This is the surface that will receive the snapped object.

e. Click to set the indicator on the surface, it will now turn 
green. 

f. Close the dialog box by clicking OK, the product will now 
snap to the desired surface.
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Step 5: Insert product (4/4)

5. Positioning the products in the world. Continued.

a. As the item snappes to the surface the Snap options

dialog box opened.

b. If the item appears upside down, activate the Alternate 

directions option by clicking in the box.

c. Clicking OK will close the Snap options dialog box and 

return you to the normal view with the product snapped in 

position. 

d. To keep this work click the Save the initial state in the 

Simulation toolbar, then use Save as to rename and save 

the file in a desired location. 

5d.

Recap lab 1

� In this laboration

� DELMIA’s advanced system of options have been
introduced.

� The virtual world have been created using a project

catalog to structure your cad parts. 

� Using a Plant Floor to simulate the facility area. 

� Inserting products and resources into a Assembly

Process Simulation



E Växell̊adan

• L̊ang axel 1st (Rod.CATPart)

• Kort axel + Drivhus 1st (Winch.CATPart)

• Ih̊alig 2x1 2st (2x1LEGO.CATPart)

• Ih̊alig 4x1 2st (4x1LEGO.CATPart)

• Ih̊alig 6x1 2st (6x1LEGO.CATPart)

• Ih̊alig 8x1 2st (8x1LEGO.CATPart)

• Platta 8x2 1st (8x1LEGO.CATPart)

• Stopp 3st (CogwheelFastener.CATPart)

• Kugghjul liten 1st (CogwheelEnd.CATPart)

• Kugghjul mellan 2st (SmallCogwheel.CATPart)

• Kugghjul stor 2st (LargeCogwheel.CATPart)

• Basplatta 1st (BasePlate.CATPart)

• Växell̊ada (GearBox.CATProduct)

Figur 4: Verklig bild av växell̊adan.
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Figur 5: Växell̊adan sammansatt som CAD-produkt.
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F PSL

Figur 6: PSL uppbyggt i CATIA.

Figur 7: Verklig bild av PSL.

Den manuella monteringscellen low level of automation är den arbetsstation närmast kameran i figur 7.
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